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1 INTRODUCTION 
Welcome to the FishInspector user guide. This software allows annotation of 

features in images of zebrafish embryos. The recent version requires images of a 

lateral position. It is important that the position is precise since deviation may 

confound with feature annotations. Images from any source can be used. However, 

depending on the image properties parameters may have to be adjusted. 

Furthermore, images obtained with normal microscope and not using an automated 

position system with embryos in glass capillaries require conversion using a KNIME 

workflow (available here). As a result of the analysis the software provides JSON 

files that contain the coordinates of the features. Coordinates are provided for eye, 

fish contour, notochord, otoliths, yolk sac, pericard and swim bladder. Furthermore, 

pigment cells in the notochord area are detected. Additional features can be 

manually annotated. It is the aim of the software to provide the coordinates, which 

are analysed subsequently to identify and quantify changes in the morphology of 

zebrafish embryos. 

 

The software has been established by support of the German Federal Ministry of 

Education and Research to the project ZFminus1 (grant number 031A582) within 

the funding scheme "Alternatives to Animal Testing". 

This program is free software: you can redistribute it and/or modify it under the 

terms of the GNU General Public License as published by the Free Software 

Foundation, either version 3 of the License, or any later version. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY 

WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 

FOR A PARTICULAR PURPOSE.  See the GNU General Public License for more details. 

You should have received a copy of the GNU General Public License along with this 

program. If not, see <http://www.gnu.org/licenses/>. 

  

https://github.com/eteixido/Knime-workflows-FishInspector


2 GETTING STARTED 

2.1 SYSTEM REQUIREMENTS 
This program is supported and has been tested on Windows 7. We cannot guarantee 

full functionality if the software is installed on other Windows versions.  

For other operating systems you can run the script from the source code (freely 

available on GitHub). This software has been written in Matlab R2015b and you will 

need a Matlab license if you want to modify the code and compile a new version. The 

software may run also on MacOS. However, it must be executed from the source 

code with a MacOS MATLAB installation or it should be compiled on MacOS 

MATLAB for being executed in a MacOS environment. Both things have not been 

tested yet. If you run the software successfully on MacOS please let us know. 

 

FishInspector software requires Matlab Runtime v 9.0. The executable 

windows file already includes its installation. 

 

2.2 KEY TO USING THIS GUIDE 
This guide includes information on:  

● Installing the FishInspector software 

● FishInspector overview 

● FishInspector feature annotation description 

2.2.1 ICONS IN THIS GUIDE 

Name Description 
Note This indicates supplementary explanations and useful tips.  

It is recommended that you read the text or follow the link. 
Terms 

This indicates terms that are useful for understanding the 
explanations. 
 

 

2.2.2 TYPOGRAPHICAL CONVENTIONS 

Convention Definition 
Forward 
Arrow → 

The forward arrow symbol → instructs you to select a series of 
menu items in a specific order. For example, Tools → Options is 
equivalent to: From the Tools menu, select Options. 

Boldface 
font 

A boldface font indicates that the given word(s) are shown as 
toolbar button or menu selection. For example, if you are told to 
select a menu item in a particular order, such as Tools → 
Options, or to click Save. 

Italic font An italic font indicates the introduction of important terminology. 
Expect to find an explanation in the same paragraph or elsewhere 
in the guide. 



Code and 
code bold 

A code font indicates you are to make a keyboard entry. It also 
shows a programming code or code examples. The code bold 

font highlights the entry. 
 

 

2.3 INSTALLING FISHINSPECTOR 
● Download the executable file from the GitHub repository: 

https://github.com/sscholz-UFZ/FishInspector/releases 

● Go to the folder where you downloaded the software: Double-click the .exe 

file to launch the Setup program. 

● On the FishInspector Installer window click Next. 

● On the Installation options window choose installation folder or leave 

the default one. Check the box Add a Shortcut to Desktop if required. Click 

Next. 

● In the required software window, click to install the Matlab Runtime 

(FishInspector software requires Matlab Runtime v 9.0). If Matlab runtime is 

already installed, click Next. 

● On the confirmation window click Next to start the FishInspector 

installation.  

● Click Finish and start using FishInspector. 

 

  

https://github.com/sscholz-UFZ/FishInspector/releases


3 FISHINSPECTOR SOFTWARE OVERVIEW 

3.1 MAIN WINDOW 
Once the FishInspector starts up, the main window appears: 

 

3.2 MAIN MENU BAR COMMANDS 
This section describes all menu commands in the File, Run, Export, Settings and 

Help menus.  

3.2.1 FILE MENU COMMANDS 

Open directory – browse the file system to retrieve images from a directory. 

Open image list – browse the file system to retrieve a text file (.txt) containing the 

full path to the image per line.  

Quit – Close the FishInspector software. 

3.2.2 RUN MENU COMMANDS 

Process all images – automatically process all images for feature extraction. 

Update feature in all images – update a specific feature for all loaded images. 

Update depended feature – if ticked updates dependent features when images are 

analysed or a feature is updated.  

Preserve manual selection – preserve a manual selection when images are 

analysed or a feature is updated. 

 

3.2.3 EXPORT MENU COMMANDS 

Export current image… – export current displayed image in png format with the 

annotated features. 

Export image list – export the list of images loaded in .txt format. 

1. Main menu bar 

2. Set input (scan folder or list 

images from file)  

3. Filter images 

4. Zoom and orientation box 

5. List of loaded images 

6. Parameter file selection 

7. Open/save shape data 

8. Image box display 

9. Features editor box 

  

 



Export all images with reduced background – export all loaded images with 

reduced background (currently only working for .tif images). 

3.2.4 SETTINGS MENU COMMANDS 

Always start editor with “Manual Selection” enabled – if ticked the image will be 

loaded with the “Manual Selection” mode enabled in the features editor box. 

3.2.5 HELP MENU COMMANDS 

Dos command – List of possible Dos commands to process images in batch mode 

with FishInspector software started from the command line in windows. 

Licenses – display license information. 

About… – display FishInspector software version, release date and link to license 

information. 

3.3 FEATURES EDITOR BOX 
This box displays the current set of features available for annotation: 

- Manual selection 

- Capillary 

- Fish contour 

- Fish eye 

- Fish Orientation 

- Central dark line 

- Bladder 

- Notochord 

- Otolith 

- Yolk sac 

- Pericard 

- Pigmentation 

 

The detection of various features is organized hierarchically, that is, in order to 

locate a certain feature the locations of previously detected features are included. 

For example, detection of the contour of the embryo is guided by the capillary 

boundaries, since the software expects the embryo to be located inside the capillary 

(or least in a virtual capillary). Subsequently, other features are identified in a 

stepwise manner (See Figure 1). Hence, the detection of specific morphological 

features is dependent on the detection of other features and is facilitated by 

excluding regions that may interfere. The identification of the regions of interest is 

driven by visual observation and measurement of generic object properties. For 

example, once the contour of the fish is localized, the eye is detected by searching 

for a dark object either in the right or left half of the zebrafish. 

 



 

Figure 1. Stepwise feature recognition by the FishInspector software. The “central dark line”, represents a 

structure of high contrast between the upper and bottom part of the fish, starting from the fish eye. This 

feature is only used to support the identification of other features and does not refer to a morphologically 

relevant entity. *Images without capillary need to be modified (i.e. insertion of a virtual capillary)by an 

automated workflow to be compliant with the FishInspector software (KNIME workflow available here). 

 

Green tick next to the feature indicates that the feature has been 

detected.  

 

Red cross next to the feature indicates that there was an error 

with the plugin and the feature can’t be detected. 

 

Red cross: This may happen for example when the capillary was not detected 

correctly (but it has a green tick), then the fish contour and any other feature 

that depends on the capillary fail and is marked by a red crosses. 

 

3.3.1 TOGGLE VISIBILITY 

Press the    icon to show or hide    the feature in the image display. 

 

3.3.2 EDIT FEATURE  

Press the    icon to access the editor window of a specific feature. 

https://github.com/eteixido/Knime-workflows-FishInspector


The editor window allows to choose between manual selection or automatic 

detection of the feature. When using the automatic detection, in most of the cases 

you will find a box containing the parameter that can be modified (1) (see section 

Modify and save parameters). The editor window also contains a display box (2) with 

the display options for that specific feature. 

 

Not all features allow manual selection or have display options. 

 

3.3.3 ENABLE OR DISABLE A FEATURE 

To enable or disable a feature, right click with the mouse on 

the feature and press (untick) Use feature. The disable 

feature will have a specific orange symbol next to it.  

  

3.4 SET PARAMETERS 
Given that establishment of a 100% correct automated feature detection would be 

very challenging and to allow improvement by the user, the software permits 

modification of the parameters used for the automated feature detection. This is 

very useful to adapt for specific image characteristics (contrast, intensity, RGB or 

grayscale, developmental stage). However, also for optimised parameters, the 

automated detection may not be successful. In this case it is possible to manually 

edit the annotation of the feature.  

The parameters of all features are stored using a json file. The FishInspector 

software comes with a set of default parameters automatically loaded from the 

parameter set box in the left bottom part of the main window.  Modified 

parameters can be saved in a specific file that can then be loaded in subsequent 

analyses with similar images. 



 

This menu allows to: 

Edit File – (Not active in recent version (1.03)) 

Open Directory – browse the file system to retrieve the folder where the 

parameters are saved. 

Rescan Directory – Refreshes the current directory that contains the parameters. 

Create New Parameter File – Allow to create a new file containing new set of 

parameters. 

Create a new parameter file if you have different types of images (from a 

different source) or different embryo stages that could differ on detection of 

the features. 

3.4.1 MODIFY AND SAVE PARAMETERS 

Features can have parameters to improve its automatic detection. These parameters 

can be modified in the editor window of each feature (see section Edit Feature). To 

modify a parameter either introduce directly a number value in the box next to the 

parameter (1) or click on the icon with a plus or minus sign (2). To save the parameters 

click on the save icon (3).  

 

To apply a change on a parameter/feature for all analysed images follow these steps:  

1. Disable the feature on the first image. 

2. Run → Update feature in all images and select the specific feature to be 

updated. 

3. Once the analysis is finished, enable the feature on the first image. 

4. Correct the parameters and save the shape data by click on the save 

SHAPE.json button on the editor window of the feature. 

5. Run → Update feature in all images and select the specific feature to update. 



    

3.5 OUTPUT DATA 
The resulting output of the FishInspector is a set of xy coordinates of the morphological 

feature detected.  

FishInspector has been programmed in MATLAB®, which stores most images as two-

dimensional arrays (i.e., matrices).Each element of the matrix corresponds to a single 

pixel in the displayed image. To access locations in images, the MATLAB Image 

Processing Toolbox™ uses several different image coordinate systems as conventions for 

representing images as arrays.  

By default, the toolbox uses a spatial coordinate system for an image that corresponds 

to the image’s pixel indices. It is called the intrinsic coordinate system and is illustrated 

in the following figure. The image is treated as a grid, ordered from top to bottom, and 

left to right. Y increases downward, while x increases to the right. 

 

Coordinates are dependent on image resolution. Hence, for a comparative 

analysis it is recommended to use images with the same resolution. Otherwise 

subsequent analysis of JSON files may require adaptation for specific image resolution. 

 

For each image analyzed, data are exported to a single JSON file, which is a language 

independent open-standard file format typically used for transmitting data between 

applications. The boundary coordinates of multiple features can then be stored in a 

structured text file. This allows the seamless integration of the FishInspector output into 

custom post-processing algorithms, which can be implemented in any programming 

language. An example of a JSON output file is given in the Annex. 

The output data file is generated in the same folder from which images have been 

loaded and takes the same name as the image file plus a suffix ending by __SHAPES. The 

output is generated by clicking either the Save SHAPE button situated on the left 

bottom part of the main window in the Shape Data box. 



  

or by click on the Save SHAPE.json button on each feature editor window (see 

chapter Edit feature).  

Open JSON File – opens the directory that contains the output Json file. 

4 LOADING IMAGES 
Images can be loaded by open a directory or by reading image list from file. 

4.1 LOAD IMAGES FROM DIRECTORY 
There are two options to proceed: 

Select File → Open directory on the menu bar to open the file dialog, browse and 

select the folder where the images are stored.  

Or select the Scan folder for images tab under the main menu bar and click   to 

open the file dialog, browse and select the folder where the images are stored. 

The names of the images loaded are displayed in the list box on the left of the main 

window. All images from parent and subfolders will be considered. 

 

4.2 LOAD IMAGE FROM IMAGE LIST FILE 
There are two options to proceed:  

Select File → Open image list on the menu bar to open the file dialog, browse and 

select the text file (.txt) containing the full path to the images. 

Or select the Read image file from file tab under the main menu bar and click  

to open the file dialog, browse and select the text file (.txt) containing the full path to 

the images. 

The names of the images loaded are displayed in the list box on the left of the main 

window. 

Most common image file formats are supported: .tif, .png, .bmp and .jpg. 

FishInspector supports RGB and grey images. 

 

4.3 IMAGE FILTER 
The image filter box allows you to refine the image list to just load and process 

selected images. Specific words can be used to selectively analyse images (e.g. 

“.bmp” will load only images with bmp format, or “_2” will load images which name 

contains these characters).  



You can also deselect images by unchecking the tick boxes at the image file names 

(see Process image) 

4.4 ZOOM TOOL 
The Zoom box is situated on the right top of the main window and allows you to 

adjust the image zoom to:  

Fit fish – it resizes the image based on the contour of the fish. 

Fit image – it resized the image to fit into the the size of the display window. 

Fit image height – it resizes the image to fit the height of the image into the display 

window. 

Fit image width – it resizes the image taking to fit the width of the image into the 

display window. 

50% – it resizes the images to the 50% of its original size. 

100% – it resizes the image to its original size. 

200% – it resizes the images to 200% of its original size. 

Custom – introduce a specific percentage to zoom out or zoom in. 

To gradually enlarge or reduce the image click the icon with the plus or minus signs.  

 

  

 

Click the  icon in the Zoom box to display the fish to its standard orientation, 

i.e. head to the left and tail to the right. In case the fish is not displayed in the 

standard orientation after activation of the  icon, the orientation of the fish has 

not been identified correctly. In this case the fish orientation feature has to be 

corrected manually (see FishOrientation).  

Standard orientation is defined as the fish with the head on the left, tail on 

the right and yolk sac on the bottom part.  

5 PROCESS IMAGE 
Once the images have been loaded you can start to analysis. Click on one image from 

the list box on the left (the name of the image will appear highlighted in blue). Then 

the detection of the features will automatically start from left to right. Loading of the 

first image may takes a bit longer. The time required for loading an image depends 

on the resolution and the computer processing power. 



Click the  icon in the Zoom box to display the fish to its standard 

orientation (more convenient for the visual analysis). 

Before starting manual correction of features check if the parameter file (see section 

Set parameters) is the one you intend to use. Every time the FishInspector is started 

it loads the default parameter file. It is recommended that parameter files are 

optimised to reduce requirement for manual editing. 

 

The tick mark on the left of the image name on the list box indicates that the 

analysis of the image is enabled, unticked images will not be analysed. 

Images may be deselected e.g. in case of insufficient positioning.   

 

 

 

5.1 FEATURE CORRECTION 
The software permits modification of the parameters used for the automatic feature 

detection or manual correction given that establishment of a 100% correct 

automated feature detection is very challenging. 

Click on the    icon to access the editor window of a specific feature. The best 

way to check and correct features is from left to right due to the dependency on 

detection of some features (see section Features editor box). 

First try to correct the parameters of the feature to see if its detection can be 

improved, and save parameters if you want them to be  used for subsequent image 

analysis (see Modify and save parameters). If no further improvement by changing 

parameters can be achieved, correct the feature manually (see section Edit Feature). 

Hold click and drag the mouse to correct the annotated lines or points.  

Once the feature is corrected, click on Save to SHAPE.json to confirm and save 

changes.  Any dependent features will be updated as well. 



To disable the update of dependent features click on Run → Update 

depended features. 

6 FEATURE DESCRIPTION 
This section contains the description of each feature and the functionality of the 

parameters of a given feature.  The description is very detailed. However, to use the 

FishInspector it may not require that you understand the underlying processes in 

detail. 

 

In the example shown above, the following features were detected : a, lower jaw tip 

using the Manual feature tool (orange), b, eye contour (green), c, fish contour (red), 

d, pericard (blue), e, yolk sac (green), f, swim bladder (blue), g, otolith (green), h, 

notochord (green), i, pigmentation (yellow). 

 

6.1 MANUAL  
The manual annotation allows to create a custom line or point to annotate feature 

for which not automatic detection tool is available. For instance, jaw morphology 

analysis is at present only possible by using the manual selection tool and be 

labeling the the lower jaw tip with a point mark. 

Press the  icon of the Manual feature. Then use the context menu (by  right click 

with the mouse on the image) to create a new line or new point. 

Hold click and drag the mouse to move a point to a different place or to 

modify the shape of a line. To enlarge or reduce the size of the point use the 

scroll wheel of the mouse.  

To delete a point or line right click with the mouse on the line or point to erase and 

click delete. 



Principally it is possible to apply multiple labels using the Manual feature tool. 

These will be stored in the order how the labels were applied. Hence, if you apply 

more than one label you need to process them in the same sequence since otherwise 

they would be confused in subsequent processing of JSON files. However, the order 

changes in case subsequent editing of a label. Hence, annotation of multiple features 

should be conducted with care. 

 

 

6.2 CAPILLARY 
The detection of the capillary is done in two steps. 

First, a binary image is generated, using a dynamic threshold based on Otsu's method 

[1], multiplied by the threshMultiplier variable. 

Second, based on the binary image, the position of the capillary wall is estimated. 

Regions at the border of the image with strong background variations and/or 

artefacts from stitching may affect detection of the capillary wall. Those regions can 

be excluded by adjusting the vertCutoff and horizCutoff variables, which represent 

fractions of the image-height and image-width respectively. 

The image below indicates the detection of the capillary, green lines indicate the 

inner capillary wall and blue lines the outer capillary outline. 

 

 

 

 

 

 

 



 

 

6.2.1 PARAMETERS 

 

threshMultiplier – modifies the threshold value obtained with the Otsu's method 

[1] using the graythresh function in MATLAB.  

vertCutoff & horizCutoff – allow to exclude regions at the border of the image 

which may have strong background or artefacts and can affect the detection of the 

capillary wall. 

steps – used to find the inner edges (lower and upper) of the capillary wall.  

6.2.2 DISPLAY OPTIONS 
showBinary – overlays the binary image in the display window. 

plotCutoffs – show or hide vertical and horizontal cut off.  

plotCapillary –  show or hide capillary annotation. 

 

6.3 FISHCONTOUR 
The detection of the fish contour is based on a binary image generated using a 

dynamic threshold based on Otsu's method [1], multiplied by the 

auto_thresh_multiplier variable. The binary is generated from the inner image 

inside the capillary. Then the biggest region is selected (to discard artefacts) and 

holes are filled using the variable imclose_dislike. Boundary coordinates are 

obtained from this binary image and this is what is called binary contour. Finally, the 

binary contour is smoothed and an active contour is used to get the fine position and 

get the boundaries of a fine contour (in red on the image below).   

 

   

[1] Otsu, N., "A 

Threshold Selection Method 

from Gray-Level Histograms," 

IEEE Transactions on Systems, 

Man, and Cybernetics, Vol. 9, 

No. 1, 1979, pp. 62-66. 



All parameters used, except the auto_thresh_multiplier, are related to the average 

capillary width of each image. I.e. images with different resolutions do not require a 

different set of parameters since they are “normalised” by the capillary width. 

6.3.1 PARAMETERS 

 

auto_thresh_multiplier – modifies the threshold value obtained with the Otsu's 

method using the graythresh function in Matlab.  

width_of_capillary_wall – all white border pixels with less than width capillary 

wall pixels are removed. 

imclose_disksize – defines the radius of the disk-shaped structuring element used 

in the imclose function in Matlab to fill the holes of the binary image.  

binary_contour_smoothing – defines the degree of smoothness of the fine contour 

goes from 0 (highly smooth contour) to infinite.  

min_peak_width  – is used in the active contour function to get the fine position of 

the fine contour. Takes values from 0 to 1, the greater the value the finest position 

takes. 

6.3.2 DISPLAY OPTIONS   

plot_binary_shape –overlays the binary shape in the display window 

plot_binary_contour – show or hide binary contour. 

plot_fine_contour – show or hide fine contour. 

 

6.4 FISHEYE 
The detection of the fish eye is based on the creation of a binary image only taking 

into account the region inside the contour of the fish. Moreover, the central part of 

the fish is excluded using the relLengthOfHead variable in order to find the darkest 

region in the two extreme parts of the fish (head or tail). 

The image below displays the region excluded from the eye detection and the eye 

outlined in green. 

   

   Active contour 

models are used to find 

the boundaries of shapes 

in an image.  



 

 

6.4.1 PARAMETERS 

 

relLengthOfHead – relative length of head to exclude central part of the fish. 

autothresh_multiplier – modifies the threshold for the detection of the eye. Reduce 

it to detect a less pigmented eye.  

6.4.2 DISPLAY OPTIONS 
showBinary – show or hide the region that is excluded from the eye detection 

showContour – show or hide the contour of the fish eye detected 

 

6.5 FISHORIENTATION  
This feature is used to determine the orientation of the fish. The orientation is shown 

by an arrow, the standard orientation of the fish is with the head on the left and yolk 

sac on the bottom part as the picture shows. The arrow needs to point towards the 

ventral, rostral side of the fish embryo (as indicated in the image below). 

 

To correct the orientation, select manual selection in the editor window of the 

feature and hold click on the red circle and drag the arrow to the correct position. 



 

6.5.1 DISPLAY OPTIONS 

showOrientation – show or hide the green arrow (orientation). 

6.5.2 OUTPUT 

The orientation of the fish embryos in the original image is described in the output 

JSON files by two variables: horitzontally_flipped and vertically_flipped.  

Remember that digital images are typically viewed with coordinates 

(indices) in which y increases downwards and x increases to the right (see 

section Output data). That should be taken into account when doing morphometric 

analysis. 

 

Standard orientation 

horitzontally_flipped:0 

vertically_flipped: 0 

 

horitzontally_flipped:1 

vertically_flipped: 0 

 

horitzontally_flipped:0 

vertically_flipped: 1 

 

horitzontally_flipped:1 

vertically_flipped: 1 

 

6.6 CENTRALDARKLINE 
This feature is used only as reference for the detection of the subsequent features 

like yolk sac or notochord.  

6.7 PARAMETERS 



 

upper_border_mindist – allows to discard the upper part of the fish, to avoid dark 

pixels (1).  

thick_part_thresh – modifies threshold of the lower excluded part (yolk sac) to 

expand or contract the area (2). 

thick_part_cutoff – allows to discard lower part of the fish that can influence on the 

detection of the central dark line (3). 

low_thresh – ??? 

 

6.7.1 DISPLAY OPTIONS 
plot_CentralDarkLine – show or hide the detected central dark line. 

plotFishContour – show or hide the detected fish contour. 

showUpperExclusion – show or hide upper part excluded. 

showThickPartExclusion – show or hide lower part excluded. 

 

6.8 BLADDER 
For the detection of the swim bladder a mask is generated to limit the principally 

possible location in the image. The mask is created along the central dark line taking 

into account the parameters that defines the region of interest (ROI, rectangle shown 

in the image below). After that a threshold is applied and the biggest dark blob is 

used to detect the swim bladder boundaries (in green).   

   

Region of interest 

(ROI): subset of an image or 

a dataset identified for a 

particular purpose. 



 

 

6.8.1 PARAMETERS 

 

ROI - Relative Offset – change the position along the central dark line of the region 

of interest. 

ROI - Relative Length – increase or decrease the length of the region of interest 

from the right position.  

ROI - Relative Vertical CutOff – wide or narrow the region of interest. 

autothresh_multiplier – modifies the threshold for the detection of the swim 

bladder.  

imclose_disksize –defines the radius of the disk-shaped structuring element used 

in the imdilate function in Matlab of the binary image.  

MinPeakWidth – is used in the active contour function to get the fine position of the 

fine contour. Takes values from 0 to 1, the greater the value the finest position takes. 

BinaryContourSmoothing – Takes values from 0 (very smoothed) to 1 (no 

smoothing at all). Used to refine contour of the bladder.  

6.8.2 DISPLAY OPTIONS 

plot threshold region – show or hide the region after the threshold. 

plot ellipse fit – show or hide the ellipse fit of the threshold area. 



plot fine contour – show or hide the fine contour of the detected bladder 

boundaries. 

show ROI – show or hide the ROI for the bladder detection. 

 

6.9 NOTOCHORD 
To detect the notochord only the upper part of the central dark line is used by 

generating a mask using the fish contour, fish eye and central dark line. The display 

option showLowerExclusion shows or hides this mask. Also an exclusion region on 

the upper part of the fish is created to improve detection of the notochord 

(showUpperExlcusion). 

 

 

6.9.1 PARAMETERS 

 

upper_border_exlcude_factor – wide or narrow the excluded border region on the 

upper part of the fish. 

low_thresh – it is used before the active contour function and changes the maxima 

of the pixel detection. 

6.9.2 DISPLAY OPTIONS 
plot_Notochord – show or hide the notochord coordinates 

showUpperExclusion – show or hide upper exclusion region of the fish. 

showLowerExclusion – show or hide initial excluded region to detect the 

notochord. 

 



6.10 OTOLITH 
The otoliths are biomineralized ear stones that contribute to both hearing and 

vestibular function in fish. Embryos have two otoliths, the utricular (anterior) and 

saccular (posterior). The figure below display the location of the two otoliths of a 

zebrafish embryo (red arrows). Usually the posterior otolith is bigger than the 

anterior. 

 

This feature is detected by first generating a mask to narrow down the region where 

to look for the otolith(s). For the mask some limits (cutoffs) are defined as variables: 

Eye Offset, Relative Length and Relative Vertical CutOff. Then a threshold is 

applied to find the darker dots that are the otoliths and finally the centroid (x,y) and 

radius of the detected object is saved as output. 

The manual selection allows to erase or create new points and modify its size.   

● Create new point: Use the context menu (by right click with the mouse on 

the image) and click new point. Hold click and drag the mouse to move a 

point to a different place. To enlarge or reduce the size of the point use the 

scroll wheel of the mouse.  

● Delete a point: right click with the mouse on the point and click delete. 

 

The otolith position is used to calculate the distance between the eye 

centroid and posterior otolith in subsequent analysis of JSON files. The 

distance depends on the developmental stage of the embryo. At present, the 

subsequent workflow requires the position of the larger, the posterior otolith. It is 

sufficient to check that the posterior otolith has received the bigger label. In the 

subsequent workflow only the position of the bigger label will be used to estimate 

the otolith-eye distance. 

6.10.1 PARAMETERS 



 

Eye Offset – moves the mask along the central dark line (close or far from the eye). 

Relative Length – Increases or decreases the width of the mask from the right part. 

Relative Vertical CutOff – increases (by decreasing the value of the parameter) or 

decreases (by increasing the value of the parameter) the height of the mask from the 

top.  

Autothresh multiplier – modifies the threshold value obtained with the Otsu's 

method used to detect the otoliths. 

6.10.2 DISPLAY OPTIONS 

plot_binary_shape – show or hide binary shape of the detected otolith. 

plot_fine_contour – show or hide otolith radius and position (ellipse). 

   showBinary – show or hide mask created for the location of the otolith. 

 

6.11 YOLK SAC 
The yolk sac is detected by excluding the upper part of the fish using the central 

dark line as reference and by using the inverted image.  For the mask the bladder is 

excluded and also everything left to the right border of the eye. Some limits (cutoffs) 

are defined as variables: Front CutOff and  Rear CutOff. The inverted image will be 

show during the edition of yolk sac boundaries. 

 

 

6.11.1 PARAMETERS 



 

Front Cutoff – increases or reduces the width on the left. To enlarge decrease the 

value. 

Rear Cutoff – increases or reduces the width on the right.. To enlarge decrease the 

value. 

MinPeakWidth – is used in the active contour function to get the fine position of the 

fine contour. Takes values from 0 to 1, the greater the value the finest position takes. 

BinaryContourSmoothing – Takes values from 0 (very smoothed) to 1 (no 

smoothing at all). Used to refine contour of the yolk and create a fine contour. 

6.11.2 DISPLAY OPTIONS 
plot_binary_shape –show or hide binary shape of the detected yolk boundaries. 

plot_fine_contour – show or hide fine contour of the yolk after smoothing. 

 

6.12 PERICARD 
At present, pericard always required manual correction and it is sometimes difficult 

to locate the boundaries precisely. To narrow its location a mask is created between 

the eye and yolk. A limit is set using the variable Eye Offset. For the detection and 

during edition it uses the inverted image. The images below show an example of the 

pericard region corrected (in blue)  in 48hpf (top picture) and 96 hpf old embryos 

(bottom picture). 

 



 

6.12.1 PARAMETERS 

 

Eye Offset – increases or reduces the width of the mask from the eye (larger values 

make the mask smaller). 

Autothresh multiplier – modifies the threshold value used to create the binary 

detected image of the pericard.   

 

6.13 PIGMENTATION 
The detection of the pigmentation is based on the detection of pigment cells inside 

the area delimited by the notochord (outlined in red in the image below). The 

pigmentation analysis was restricted to the notochord region to reduce variability. 

Many pigment cells are located dorsally. However, slight differences in position of 

the embryo may impact on the number of pigment cells visible in the lateral image. 

Hence, we included only regions where we anticipated that the number of pigment 

cells may not be affected by differences in positioning.  A mask is created that uses 

the variables, ROI - Relative Offset and ROI - Relative Length. Pigment cells are 

detected applying a threshold (Autothresh multiplier). 

 

 

 

 



6.13.1 PARAMETERS 

 

ROI - Relative Offset –increases or reduces the width of the mask from the head 

region. Adjust this Offset to avoid the detection of otoliths. 

ROI - Relative Length – Increases or reduces the length of the mask from the tail 

position of the fish embryo. 

Autothresh multiplier – modifies the threshold value to identify the pigment cells. 

Increasing values, increases the threshold to detect darker pigmented cells. 

It is important to use the same Autothresh multiplier in all images if your 

objective is to detect changes in pigmentation area (sum area of pigment 

cells detected). If the threshold would be changed image to image the area of 

pigment cells would be affected and compromise a comparative analysis!  

6.13.2 DISPLAY OPTIONS 
plot_binary_shape – show or hide boundaries of the pigment cells detected. 

showBinary – show or hide the mask of the area for the location of the pigment 

cells. 

 

 

  



7 ROTATE AND CROP IMAGES WORKFLOW 
 Images not obtained by automatic positioning in a glass capillary - and hence, not presenting capillary 

boundaries - can be used as well but require automatic conversion to an image with a virtual capillary. 

This can be done with a KNIME workflow and an embedded imageJ macro (download here). The workflow 

can handle multiple images simultaneously in a loop. Depending on the image quality certain parameters 

of the workflow may have to be adjusted. Images of embryos from a lateral orientation are required. The 

workflow is prepared for RGB images but it can be adapted for grayscale images. 

  

Knime extensions required: 

·         Knime community contributions - Image Processing 
·         Image processing - ImageJ extension 
·         Knime Quick Forms 
 

7.1 INSTRUCTIONS 
1. List files node: Browse to 

select the folder that contains 
the images and if necessary 
change extension.  

    
Note: all pictures must have the 
same size 

 
2. Just for the first picture: click on 

Column Filter node and 
execute  

 

 

https://github.com/eteixido/Knime-workflows-FishInspector


3. Adjust the threshold value on 
the Global Thresholder node. 

  
 
 
Execute the node and open view to 
check that the binary image 
contains the fish.   

 

 
4. The next node inverts the 

image, if your image has a white 
background, skip the node. 
Image should be with black 
background like the image on 
the right.  

 
5. Adjust labeling filter node. If 

there is small noise to remove 
from the background. (It 
depends on image size). 

 



6. Execute the ImageJ Macro node 
after the Bounding box crop 
wrapped metanode in order to 
check if the image has been crop 
and the fish is completely 
visible and with the head on the 
right. 

 
7. Adjust bounding box 

parameters (height, width, 
border or x coord) by double-
click on the Bounding box crop 
wrapped metanode. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Execute and view ImageJ 
macro node to check again. 
The image should contain 

the totality of the fish.  

 

 

 
 

 

8. Execute the last Loop End node. 

 



9. Once finish, in the next Joiner 
node.  
 Right-click and click on 

Joiner table. 
 Select the images that were 

correctly processed: In the 
Joiner table window, click 
on the row ID of the image 
and then right click and 
click on HiLite Selected. 

 

 Annotate the row number 
or name of the images that 
were not correctly 
processed. 

 

10. Double-click on the Image 
Writer node and click on 
Browse to define the folder 
were you want to save the 
cropped images. 

 



11. To process the images 
incorrectly cropped. Attached 
after the List Files node a row 
filter node and filter by row the 
image previously annotated. 

 
 

 
12. Adjust bounding box crop 

parameters to completely see 
the fish and execute the 
workflow again. 

 

 

 

 


